Using the LPA DBE System
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I. Retrieving Login Information

It’s normal to forget password information. Retrieving your password information is a simple
process to follow.

1. Go to the Log-In interface: Arizona LPA Management System:
https://arizonalpa.dbesystem.com

2. C(Click on “Log In”

3. Click on “Forgot Password”

System Access Login
Username

FORGOT USERNAME / ACCOUNT LOOKUP

Password

FORGOT PASSWORD

[] Remember Username

4. Enter your email and click “Submit”

Reset Password

Enter your email address, username, or user number in the box below and
we will create a one-time use password and send it to the registered email
address for the account. You will be required to reset your password after
login. If you do not know your username, you can look it up.

email@gmail.com h

5. The password information will be sent shortly to the email address that was entered

Contact BECO at (602) 712-7761 for further assistance



https://arizonalpa.dbesystem.com/

II. Creating a Contract

1. Under Create, click “New Contract”

The System Dashboard

AZUTRACS """é

LPA DBE System (Ml

= = 1] S
Home
View »

Reporting »

New Vendor

New Contract

New Message

Tools »
Settings »
Help & Support »

Contracts
All (open & cosed)

Value

$471MM

All Open $283MM

All Audited £283MM

All Closed £18EMM

Pending Value Change
value of -$243K.

Pending End Date Change

Contract Audits
Total Audits
Incomplete Audits =
Discrepancies =
Closeouts/Final =

Payments
For Credit

$375MM
£33MM
$173MM
£12MM
$173MM
$12MM

£202MM
$21MM

2 contract worth $2MM with total change

26 contract worth $28MM.

% Goal
%e Cradit
4.4%0
8.7%
4.8%
6.7 %0
4.8%
6.7 %

3.6%
10.5%

2. Enter appropriate data in fields marked with a red asterisk (*)

Contract: Compose

On this page, you can compose your contract. There are two steps to this process: (1) Composing and (2) Reviewing your contract. Whe

click Review at the bottom of the page.

* required entry

Contract Information

You must enter a contract title and maximum value. The assigned department field is optional.

Contract Title =

Contract Number *
Contract Value (%) *

Contract Secondary Status

Contract Holder/Owner *

Department *
TRACS Project Number
Federal Project Humber *

ECS Contract Number

Project Title

| Contract Number

| 1,000,000.00

None selected ~

Arizona Local Public Agency

MName shown to contractors as the contract owner/paying organization when

None selected

-

MNone selected

Arizona LPA Default Buyer
City of Apache Junction

City of Avondale

City of Benson

City of Bisbee

Fiat ™ £0 L

-~




3. Click on “Get Vendor” to select the correct vendor profile; firms may have multiple profiles for
the different cities they do business in
4. Identify the Prime Compliance Contact person and Prime Address

Contract Dates

Enter a contract start date and end date. These are the dates that you want the auditing (if selected) to begin and end.

Award/Start Date * [mm/dd/yyyy) LProjected] End Date

_ Date:
[mm/dd/yyyy)
* Duration: year(s) [x]

Notice To Proceed Date [mm/dd/yyyy)

Prime Contractor Information

The coniract must be assigned to a prime contractor. Enter the B2Gnow user number for the prime contractor, or click Get Vendor
to search and select 3 user.

Prime Contractor * Type name of vendor:
- use * before and after text for wildcard (e.g. ¥facme*)
- not case sensitive, but punctuation and spaces are important
- after selecting prime, the contact and address fields will auta-fill

n vendor database
Prime Compliance Contact * None selected E'

Contact not listed? QuickAdd a new compliance contact.

Prime Address * None selected [ =]
Address not listed? QuickAdd = new address.

5. Select the appropriate “Buyer/Project Manager (in-system user)”, your agency

Organization Contacts

The contract must be assigned 1o a buyer/contract administrator; select a user from the list. Additional contacts can De designated.

Buyer/Project Manager (in-system user) * Mone selected [=]
Additional Organization Contacts

Name Department Email, Phone & Fax
Contact #1:
Ext

Contact #2:

Contact #3:

mTmMmmTm®T DM




6. The top portion of “Contract Settings” should be filled out this way:

Contract Settings

Diversity Goal(s) * Proposed,

Committed
Goal

Goal Required
Type Goal

Help with goals DBE: % % %

External Funding Sources

> Hain with fundin : Funding source based on | -- select one -- B

Category % Value %% Proportion FAA
Federal: § q, = Caleulate

State: § % HUD:
Locall § %

Contract Type * None selected [=]
Contract Category None selected [~ |
Prime Permitted to Self-Request Additional @ Yes [default] - Prime can self-request additional subcontractors electronically, ALL are subject to approval by
Subcontractors * authorized staff.
Yes - Prime can self-request additional subcontractors electronically. For Credit subcontractors are subject to
approval by authorized staff, other subcentractors will automatically be added to the contract.
Yes - Prime can self-request additional subcontractors electronically; ALL are auto-approved and added fo the
contract.
No - All subconiractor additional requests must be submitted in writing.

Federal Funding Source * MNone selected El

Contract Settings

Diversity Goal(s) # Proposed/
Committed A(SEL;E'"
Goal

Goal Required
Type Goal

» Help with goals

DBE: IO o) ‘IO 0 IO %

External Funding Sources
g Funding source based on I percent j FHWA3|94-3 %o

» Help with funding sources FTA

I %
Categary % Value % Proportion
aen ik 2
Federal: # g 943 oy, « Calculate

I | : RA:l %

“Required Goal”: Assessed DBE Goal from BECO email or letter

“Proposed/Committed Goal & Actual Goal”: Contractor’s DBE goal commitment from the
DBE Intended Participation Affidavit Summary

If no goal assigned to contract, then type a zero (0) in all three - Required Goal, Proposed/
Committed Goal and Actual Goal

“Funding source based on”: Select “percent” from the drop down menu
“FHWA/FTA/FAA”: Enter appropriate funding percentage

Click on the “Calculate” link and the percentage will auto populate in the “% Proportion”
field

7. Additional important fields to complete:
a. “Contract Type”: Select whether the contract is Construction, Professional Services or
Procurement
b. “Funding Source”: Select “FHWA”, “FTA” or “FAA” from drop down menu
c. “Federally Funded”: Select Yes from drop down menu

8. Enter the appropriate person as the Compliance Officer
9. All other default settings shall remain the same

10. Scroll to bottom of page and Review | click

11. Scroll to bottom of page and _sae | click




IIL.Approving Sub Requests

1. View “Sub Requests” from the Dashboard
2. Click on any underlined number to access Sub Requests; or click the “View” tab, then “Sub

Requests”

Ll

oV

AZUTRAC

LPA DBE System (i

> a3

The System Dashboard Refresh  Personalize ()

Contract Audits
Total Audits

"
w
a8
o
w

W

Inconceivable! You have reached
Power User Level 2

Inc I Audits

Home

View »

Search »
Reporting »
Create »

Tools »

Settings »

Help & Support »
Logoff

Show All Hide All

Logged on as:

Mayline Wahinepio
Arizona Department of
Transportation

Discrepancies
Closeouts/Final
Past Due Audits

I Sub Requests

Priority Flagged Contracts

Contract Value
Total Payments
Credit Payments
%£101,197,109
£105,572,531
6,967,732
£27,082,800
£27,255,732
£1,453,411

La
o o 120 18 8

Contract #
H816301C

- - - - Status & Dates
Displaying Organization Data - Config

Open
5/2014 to 1/2020

%o Goal
% Credit
3.0%
6.3%
5.8%
5.5%
5.8%
5.5%
1.8%
5.0%

Payments
Value For Credit

55.58
£348MM

51.48
£142MM

51.48
£142MM

54.18
S206MM

39 contract worth $7MM,

25 contract worth $26MM with
total change value of SEMM.

170 contract worth $319MM.

Contracts HEB5801C

Open
6/2014 to 1/2020

All {open & closad) 56.0B

All Open 51.88

All Audited 51.8B
Contracts
Total active
Audited
Soon to end (2 mo)
New
Changed

All Closed 54.28

Pending Lock-in
Pending Value Changs

Pending End Date Change

Displaying Organization Data - Config on Data - Config

3. Click on any underlined information to access the request

AZUTRACS &

LPA DBE System

Home

View »

Search »
Reporting »
Create »

Tools »

Settings »

Help & Support »
Logoff

Show all Hide All

Logged on as:
Mayline Wahinepio
Arizona Department of
Transportation

Help & Tools 3%

Transactions: Contract Subcontractor Addition Requests

Contracts | Contract Audits | SuhRequtS| Propossls | Cert Apps| Cert Change Requests | AZUTRACS Regi | support | Messages|

Displays all Contract Subcontractor Addition Reguests. Click the Reference Number to view the request details. Click the Contract Number to view the
coniract details.

I:‘ Show ONLY records assigned to you

Records per page | 20

Refrash Tabld

1 - 10 of 10 records displayed: Previous Page < Page @ 1 > Next Page

To resort click on column title. To filter click on the drop down menu.
New ¥ Date & Time Reference # Contract Number Prime Contractor Subcontractor Contract Title

Al All All All All Al [v]

[ 1/20/2016 H850401C Prime: ValleyCrest Landscape Developement, Inc.
Sub: gherty Painting C:

SR203L, THOMAS RD-CAMELBACK RD

Prime: ValleyCrest Landscape Developement, Inc.

Sub: Adams Fence LLC

SR203L, THOMAS RD-CAMELBACK RD

Prime: Cactus Transport , Inc.

Sub: Sunline Contracting LLC

WELCOME ST. - PIMA COUNTY LINE

Status

Pending

01331287-023 Pending

- ending
1/20/2016 01331287-022 H850401C Pendi

12/21/72015 01576119-003 Ha374801C Pending

12/21/2015 01576119-002 H874801C Prime: Cactus Transport , Inc. Pending
Sub: Cesar Correa Trucking LLC

WELCOME ST. - PIMA COUNTY LINE
Prime: Roadway Electric LLC
Sub: Five G Inc.

I-10, LITCHFIELD RD TO 82 AVE

Prime: T. ¥. LIN INTERNATIONAL
Suh: Arch lonical Consulting Services, 1d

12/11/2015 01516262-014 H864201C Pending

11/9/2015 00574774-012 2011-020.2% Pending




4. Review the information, and then click “Approve Request”

Contract Management: View Subcontractor Addition Request

ST TRACS

Mainl ‘.ﬁewl Seﬂingsl Su'bsl Docsl Change COrders & Task Ordersl Aler‘tsl Cm'm'nentsl 'Messagesl Closeoutl
Compliance Audit List | Compliance Audit Summary | Compliance Audit FY | Reviews | Site Visits| Reports|

1C: I-10, LITCHFIELD RD TO 82 AVE Status: Open

=] = Prima: Roadway Electric LLC Current Award: $3,625,950
—  — = g¢/8/2015-1/1/2020 Goal: 11.33% Totzl Paid: $199,384
Home % Credit: 25.14%  For Credit:  $50,259

View »
Search »

‘endors
Certified Vendors Approve Request | | Deny Request
Usars

Contracts

Proposals .
Cartification Apps Request Status Pending

Search Results » Subcontractor Five G Inc.
rting » Prime Roadway Electric LLC
Count Towards Certified Goal Yes - assigned to DBE goal
Create » Contract Title 110, LITCHFIELD RD TO 83 AVE
Tools » Date Requested 12/11/2015

e i Recommendations
Help & Support » No recommendations made.
Logoff
Show All Hide All Subcontractor Information
Logged on as: Subcontractor Name Five G Inc.
:‘;:L‘:: ;‘Lap";:'l‘;ll’:; ¢ of |System Vendor Number 20053921
Transportation Subcontractor Compliance Contact Person  Gail Gray
Phone 602-437-0201
Fax 602-437-4937
Email fiveg@fiveqinc.com

Address 3801 E. Superior Ave.
Phoenix, AZ 85040

5. Ifthe subcontractor is a DBE firm, their certification would appear like below:

Applicable Vendor Certifications

Type Certified Renewal Expiration Organization
DBE 32412015 413/2016 4/3/2016  City of Phoenix

6. DBE certifications require special attention to the following fields:
a. “Subcontract Amount”: If they are a committed DBE, is this amount at least the same as
what was on the DBE affidavit?
“Type of Participation”: Ensure the correct credit participation is selected
“Include in Compliance Audits?”: Yes
“Count Towards Certified Goal”: Yes - assigned to DBE goal (No, if the vendor is not a
DBE)

Subcontract Information

Subcontractor Tier Tier 1 subcontractor to Roadway Electric LLC [Prime Contractor]
Current Contract Amount $3,625,050.47

Subcontract Percent 0.607%

Subcontract Amount $21,997.53

Type of Participation Subcontractor/Subconsultant at 100.0% Participation

- Firm that directly provides services for the contract.
Include in Compliance Audits? Yes - subcontractor is active and should be included in the periodic audits of the contract.
Count Towards Certified Goal Yes - assigned to DBE goal
Subcontract Award Date 914/2015
Estimated Work Start Date 12/14/2015




e. Review attached files by clicking “View Attachments” button
f. “Work Codes”: NAICS codes should be selected for DBEs

Estimated Work End Date 9M7/2016

Add vendor to existing compliance audits for No. Subcontractor's first audit will be the next one. Payments Already Made: $0.00
this contract

Reference |dentifier

Aftached File(s) View Attachments

Work Description MEDIAN CABLE BARRIER
‘Work Codes No Codes Assigned
Comments NEW CONTRACT

Requesting Vendor and Contact Person

Frime Mame Roadway Electric LLC

System Vendor Number 20062603

Prime Contact Person Susan Skalniak

Phone 602-943-8300

Fax 602-943-8305

Email susans@roadwayelectric.com

Address 2035 W. Mountain View Road
Phoenix, AZ 85021

l Approve Request l l Deny Request l

g. Approve or deny request as needed; information can be altered by staff member after
clicking “Approve Request”

Message from webpage A u

I@I You have the authority to approve this request.

On the next page, confirm the subcontract details and save the record.
The request will automatically be approved at the end.

If you do not complete the process, the request will
not be approved and you will be able to finish later.

0K ] [ Cancel

h. Click “OK” when message box pops up

Review all information and settings in this record carefully; it was submitted as a subcontractor request.

Opportunity to modify information

e Type of Participation: Select the correct type of participation

icil il *
Type of Participation Subcontractor/Subconsultant

Percent of payments to be counted: | 100.00 %
Amount not to be included in award verification: § 0.00

e Count Towards Certified Goal: If the firm is a DBE select “Yes” and “DBE” in Goal Type
drop down menu

Count Towards Certified Goal * This setting is used only to set the default status on future compliance audits and the starting/final amount
fields below. To change the status of all or specific existing payments, access the payment history for the
contractor.

(O] Yes - Payments to this contractor count towards the selected goal (field below).
() No
Goal Type DBE




e  Work Codes: If sub is a DBE, select the NAICS code that applies to the work being done
e C(lick “Assign Selected Work Codes” button

Work Description MEDIAN CABLE BARRIER
Work Codes Currently assigned work codes:

Mo Codes Assigned
The work codes below are from recognized certifications for this firm. Select one or more work codes that

match the work this firm will be performing for this assignment and click Assign Selected Work Codes to
add to this record. Click here fo refresh the list if the assigned vendor or for credit status has been

[] NAICS 237310 Guardrail construction

[ MNAICS 2389090 Fence installation (except electronic containment fencing for pets)

O MNAICS 2389090 Fencing contractors {except electronic containment fencing for pets)

T s 2 n rection

Assign Selected Work Codes Add Other Work Codes

Click “Review”, and Save | then

IV.Posting Payments to Contracts

1. To find contract click “Search” tab in the left margin; then click “Contracts”
2. “Contract/Reference Number”: Enter contract number; then click “Enter”

Search: Contracts Help & Tools 3¢

AZ hos
qlﬁﬁ,g§l’j’ Usersl Vendorsl Contracts | F'mmsﬂsl
Search your organization's contract database. Enter information into any of the boxes below and click Search. Some parameters are required.
= = -
EEEE—— l Search First 20 Matches l I Search All Matches ] l Clear Form l
Home

View »

| Search »
| Verndo= || |Contract/Reference Number
Cartified Vendors

Search Parameters

1970-01

Contract Title
Contracts
Propasals

Containing Text

3. Click on any underlined field to enter contract

Search: Contracts Help & Tools 3%
AZ gg_hm
ULIEEL%E%I.X& Users | Vendors | Contracts | Propossls |

Here's a list of the contracts that matched your search criteria. Use the sort and filter functions of the table to reduce the size of the list. You can view more listings
by using the navigatien line at the bottom of the table

s =

—— Click the Transaction Number fo view that Coniract or the Vendor Name link to view that vendor's profile. To refine or expand your search use the search table at
Home the bottom of the page.
View » To resort, click on column title.

Contract Contract A it &
Search » ﬁ Contract Title Prime Contractor Setrac . Smaunt

End Date Status
Vendors
Al o] NI ALL v Al ~
Certified Vendors

Us=rs . BECO Test ADOT On-Call Prime £5,000.00 Open
10/10/2020
Contracts

Main View Audit List
Subs Audit Summary

1-1 of 1 record displayed: Page 1




4. Click on “Compliance Audit List” tab

Contract Management
AZUTRACS 898
LPA DBE systerm #l I Su'bsl Docsl Change Orders & Task Ordersl Alertsl ODTrrnerrtsI Messagesl Closeoutl

Compliance Audit List § Compliance Audit 5urnmary| Compliance Audit FYl Rew'ewsl Site \"lsﬂsl Repor!sl
- TOTOUTT Status: Open
= = Prime: ADOT On-Call Prime Current Award: $5,000
_ =  7/18/2013- 10/10/2020 Goal: 0.00% Total Paid: $3,000
% Credit: 0.00% For Credit: %0
View »

Home

"‘ ¢/ Add to Dashboard as Priority Flagged Contract Refresh Page
Search » Contract Information

Vendors Contract Title BECO Test
Certified Vendors Contract Number 1970.01
Users

Prime Contractor ADOT On-Call Prime

5. Go to the appropriate payment month and click “Add Audit”

Contract Management: Compliance Audit List

“UTRACS £

Mainl \.f'lewl Seﬂingsl Subsl Docsl Change Orders & Task Oniarsl Aler’isl Comrnanlsl 'Messagesl CIUseuull

Compliance Audit List | Compliance Audit Summary | Compiiance Audit F| Reviews | Site Visits | Reports|

————————————— 1970.01: BECO Test Status: Open
L= = 5§  Prime: ADOT On-Call Prime Current Award: $5,000
— — —  7/18/2013 - 10/10/2020 Goal: 0.00% Total Paid: $3,000
Home % Credit: 0.00% For Cradit: %0
View »

Search » Compliance Audit List

Vendars T B Reported By Mot Reported Confirmed By Not Confirmed Disp
Cartified Vendors Audit Period Date Posted = Total Lines Prime By Prime Sub

Users Lines Amount Lines Lines A t Lines
Contracts

TOTALS 43,000 $1,500
Proposals

uted By
By Sub Sub Actions
A it Lines A 13

o o $0 $1,500 © 50
Certification Apps

Search Results =

Dec 2015 Audit not posted for this pal
Nowv 2015
Reporting » Oct 2015

Sep 2015

Add Audit
Add Audit
Add Audit
Add Audit

Audit not postad for this period - Add Audit
Audit not posted for this period - Add Audit
Audit not posted for this period - Add Audit

6. Click “Add Audit and Notify Prime”; then “OK”

Contract Management: Compliance Audit List
AZUTRACS 253

Mainl ‘.ﬁewl Seﬂingsl Su'bsl Docsl Change Crders & Task Orders' A\er‘tsl Cm'm'nentsl 'Messagesl Closeoutl

Compliance Audit List | Gompliance Audit Summary | Complianse Audit F| Reviews | Site Visits| Reports |
1970.01: BECO Test Status: Open
Prime: ADOT On-Call Prime Current Award: $5,000
7/18/2013 - 10/10/2020 Goal: 0.00%  Total Paid: $2,000
% Credit: 0.00% For Credit:
View »

Search » Compliance Audit List

Vendars —— Reported By Not Reported Confirmed By Not Confirmed Disputed By
Certified Vendors Audit Period Date Posted ;rlim: Total Lines Prime By Prime Sub By Sub Sub
Usars Lines Amount Lines

Lines Lines Lines
Cantracts TOTALS

Actions

£3,000 1 $1,500 o 0 $0 1 $1,500 © $0
Dec 2015

Audit not posted for this period - Add Audit Add Audit

I 2dd Audit and Motify Prima !&dd Audit and Do Not Notify Prime Add Audit For Specific Subcontractors

Nov 2015
Oct 2015
Son 3015

Audit not posted for this period - Add Audit
Audit not postad for this period - Add Audit
Audit nnt nactad Enc thi ind = Add Auadie

Add Audit
Add Audit
Acdd it




7. Click “View Audit”

AZUTRACS #%%

LPA DBE System AL

= =
Home
View »

Search »
Vendors

Certified Vendors
Usars

Contracts
Proposals
Cartification Apps
Search Results »

L Renorting »

Contract Management: Compliance Audit List Help & Tools 3¢

Main | View| Settings | Subs | Docs | Change Orders & Task Orders | Alerts| Comments | Messages| Closeout|

Compliance Audit List | Compliance Audt Summary | Compliance Audit F | Reviews | Site Visits| Repors |

1970.01: BECO Test Status: Open
Prime: ADOT On-Call Prime Current Award: $5,000
7/18/2013 - 10/10/2020

Goal: 0.00% Total Paid: $2,000
% Credit: 0.00% For Cradit: %0

Compliance Audit List

= Reported By Mot Reported Confirmed By MNot Confirmed Disputed By
Audit Period Date Posted p;r'imT: Total Linas Prime By Prime Sub By Sub Sub

Lines Amount Lines Lines A t Lines A

it Lines A
TOTALS $3,000

1 $1,500 1 0 $0 1 %1,500 ©
Dec 2015 1/15/2016 Mot reported ]
Nov 2015
Oct 2015

50 1 o 50 o =0
Audit not posted for this period - Add Audit
Audit not posted for this period - Add Audit

8. Click “Submit” next to Payment to Prime

LPA DBE System fNL_Ti

o=
Home
View »
Search »
Vendors
Certified Vendors
Users

Contradts
Proposals

Certification Apps
Search Results »

Reporting »
Create »
Tools »

Settings »

AZUTRACS ?.'.‘"'i

Compliance Audit: Audit Summary for December 2015 Help & Tools 3¢

main | View| Setiings | Subs | Docs| Change Orders & Task Orders | Aterts| Comments | Messages| Closeout|

Compliance Audit List| Compliance Audit Summary | Comliance Audit FY | Reviews | Site Visits| Reports |
1970.01: BECO Test Status: Open
Prime: ADOT On-Call Prime Current Award: $5,000
7/18/2013 - 10/10/2020 Goal: 0.00% Total Paid: $3,000

% Credit: 0.00% For Credit: $0

Audit Information
Audit Time Period December 2015

Audit Reference Add Reference
System Audit Number 00925690-003

Date Posted Local: 119/2016 4:16:39 PM AZT
System: 1/19/2016 5:16:39 PM CST

Final Audit? No {mark audit as final)

Payment Reporting Status 1 payments to subcontractors remaining to be reported by prime
Reporting deadline is 2/2/2016
Audit will belackad 20102016

Payment to Prime Not Reportefl  (Submit

<< View May 2015 Audit <<




9. Enter payment information, click “Save”, and then “OK”

Compliance Audit: Audit Summary for December 2015 Help & Tools 3%

AZUTRACS 293
oh ot sy M Main | View| Seftings | Subs | Doss| Change Orders & Task Orders | Alerts | Comments | Messages| Closeout|
c Audit List | Compliance Audit y| Compliance Audit Fy | Reviews | Site Visits | Reports |
——————————— 1970.01: BECD Test Status: Open
LR Sp  Prime: ADOT On-Call Prime Current Award: $5,000
— — = 7/18/2013 - 10/10/2020 Goal: 0.00% Total Paid: $3,000
Home % Credit: 0.00% For Credit: %0

View »
Pl Audit Information

Search » — :

b | Audit Time Period December 2015

Vend
=neers Audit Reference Add Reference

Certified Vendors
Usars System Audit Number 00925690-003

Contracts Date Posted Local: 1/19/2016 4:16:39 PM AZT
Proposals System: 1/19/2016 5:16:39 PM CST

Cartification Apps Final Audit? Mo (mark audit as final)

Search Results » FPayment Reporting Status 1 payments to subcontractors remaining to be reported by prime
i Reporting deadline is 2/2/2016
Reporting » Audit will be locked 3/19/2016

Create » Payment to Prime Not Reported (Submit)
Tools »

- You can add the ameount paid to the prime. Any changes will permanently replace information from your
Settings » financial systam.

Help & Support »

Logoff
Show All Hide All Payment Date 12(16/2015 | (mm/ddiyyyy)

Amount For December 2015§* 5 2000.00

Logged on as: #®

Mayline Wahinepio Comments PO# XXXX-001
Arizona Department of
Transportation

l Save l l Spell Check l l Clear Payment Info

V. Resolving Discrepancies

Discrepancies happen when subcontractors report payment amounts that differ from what the
contractor originally reported. Discrepancies can be viewed from your personalized dashboard.

1. Click on any underlined numbers to view all discrepancies

The System Dashboard Refresh Personalize ({))

Contract Audits
Total Audits
Incomplete Audits

Nothing can stop you now! You have reached
Power User Level 2

Discrepancies

Closeouts/Final
Past Due Audits
Locked Audits
Sub Requests

Priority Flagged Contracts

I8
I 10l [S flen

Contract Value
Total Payments
Contract # Cradit Payments

H816301C $101,157,10%

Displaying Organization Data - Config




2. Click any audit period to go to a contract with a discrepancy

Transactions: Contract Audits Help & Tools 3§

Contracts || Gontract Audits | Sub Requests| Proposals | Cert Apps | Cert Changs Requests | AZUTRACS Regisirations | Support | Messages|
Displays all audits. Click the transaction number to view.
[¥] Show ONLY records assigned to you

1 - 3 of 3 records displayed: Previous Page < Page > Next Page Records per page | 20

Ta resort click on calumn title, To filter click on the drop down menu. Refrash Table

Status ¥ Audit Period Contract Contract Title Paid to Prime

Discrepancy
1 Discrepancy December 2015 H752001C Sunland Inc. Asphalt and Sealcoating 50,00
US 180, BEAVER DAM TO RANCH

1 Discrepancy December 2015 HB858301C Ames Combs Joint Venture $404,719.63
Pending sub (1) US 93, § SR71 TO N SR83

1 Discrepancy I November 2015 HB858301C I Ames Combs Joint Venture $339,015.86
US 93, S SR71 TO N SR8S

3. Find the “Discrepancy” in the audit list
4. Click “Resolve” to enter discrepancy module

Contractors Termite & Pest Control, No Not included in audit $1,282.40 0.032%
Inc. [Info] Final payment made
Cory Malmin Add to audit
cory@contractorstermite.com
P £23-780-0308, F 622-780-0303
Fisher Sand & Gravel [Info] No . Confirmed 0.357%
Emilv Young it Wiew Edit
emyoung@fisherind.com
P 480-730-1033, F 480-720-1264

Gerdau Reinforcing Steel [Info] Ne. .00 Confirmed $278,388.25 2.441%
Denielle Segal it Wiew Edit
Danielle.Seqal@Gerdsu.com
P £58-737-7610

PARADISE REBAR, INC. [Infc] Ne $23,241.85 Discrepancy 528,006,598 1.005%
Connie Valadez Resolve  Resclve
conniev@paradiserebar.com = e
P 602-447-0829

Hawker and Evans Asphalt Compan No $0.00 Confirmed 0.955%
Inc [Info] View Edi

Dennis Ryan

dennisr@hawkerevans.com

P 480-824-2058, F 480-461-1055

Himes Consulting, L.L.C. [Info] Not included in audit £7,916.50 0.240%
3ill Himes Final payment made




5. Review discrepancy data

Compliance Audit: Discrepancy Resolution

Main | View| Settings | Subs | Docs | Change Orders & Task Orders | Alerts | Comments | Messeges | Closeout|

Compliance Audit List| Compliance Audit Summary | Compliance Audit | Reviews | Site isits| Reports |

H858301C: US 93, S SR71 TO N SR89 Status: Open

Prima: Ames Combs Joint Venture Current Award: $12,481,908

12/24/2014 - 1/1/2020 Goal: 9.87% Total Paid: $11,065,311
9 Credit: 5.93%0 For Credit:  $656,387

A discrepancy has been reported for this audit for the listed time period. If the audit is pending a response, click the Resolve Discrepancy bution to
submit information.

[ Resolve Discrepancy ‘ I November 2015 Audit | [ Subcontractor Payment History ‘

Discrepancy Resolution

Status Awaiting subprime and subcontractor response.

Audit Information
Audit Time Period November 2015
Audit Number 01331286-070

al Audit Data Reported
Amount Reported by SubPrime §23,241.85 NOT included in Goal (change)
Amount Reported by Subcontractor §20,743 "“:—
Payment Date (SubPrime Reported) 12i7/2015

Payment Date (Sub Reported) 11i3/2015

Retainage Withheld? No

Prompt Payment? (SubPrime Reported) Yes - paid within 7 days

Prompt Payment? (Sub Reported) NA

Subcontractor Private Comments Check #216566 was issued for 2 projects but only 20743.06 was for this project.

Discrepancy Resolution Data Reported
New Amount Reported by SubPrime No response yet. g

Different amounts and dates reported
by the subprime and subcontractor.

New Amount Reported by Subcontractor No response yet. -

Compliance Officer Mayline Wahinepio

Crganization Arizona Department of Transportation
User Number 30000085-241

Email mwahinepio@azdot.gov

Phone 602-712-8191

Fax 602-712-8429

SubPrime Information Subcontractor Information

Business Name Gerdau Reinforcing Steel Business Name PARADISE REBAR. INC.
Vendor Number 20187335 ‘Vendor Number 20062545

Firms are sent a notification to resolve
the discrepancy on their own. These
firms have not added additional
comments to resolve this discrepancy.

Contact Danielle Segal Contact Connie Valadez :
Email Danielle.Segal@Gerdau.com Email conniev@paradiserebar.com
Phone 858-737-7610 Phone 602-447-0839

Fax Fax

Contact persons that responded to
payment audit.

SubPrime Audit ubcontractor Audit
Responder Responder
Name Tina Hamilton Name Joel L. Raschke

Response Dale Local: 12/18/2015 1:57:49 PM AZT Response Date Local: 1/12/2016 9:43:33 AM AZT
System: 12/18i/2015 2:57:49 PM CST System: 1/12/2016 10:43:33 AM CST

SubPrime Discrepancy Response Subcontractor Discrepancy Response
Responder Responder
No response yet. No response yet.

[ Resolve Discrepancy ‘ I November 2015 Audit | [ Subcontractor Payment History ‘

6. Verify correct payment information by communicating with each firm
7. Click “Resolve Discrepancy” button




8. Enter final payment information

Compliance Audit: Discr

Resoluti

( ¥

Main | iew| Settings | Subs| Docs | Change Orders & Task Orders | Alents | Comments | Messages| Closeout]
Complisnce et List | Comptisnce A Summary | Compliance sudit Fr | Reviews | Ste visis | Reports |

Status: Open
Frme; A ——— Current Award: $12,481,908
12/24/207T¥ - Ij Iy T0TT Goal: 9.87% Total Paid: $11,065,911

8% Credit: 59306 Far Cradit: $656,287

A discrepancy has been reported for this audit for the listed time period. If the audit is pending a response, click the Resolve Discrepancy button to
submit information.

Resolve Discrepancy | | November 2015 Audit | | Subcontractor Payment History |

Select a resolution option, enter comments if needed, and click Save Response.

Discrepancy Resolved? * () The $23,241.85 criginally reported by the subprime is comect.

(@) The $20,743.06 originally reported by the subcontractor is correct
) None of the amounts are commect. The amount should be §

Public Comments. These commaents are visible to all parties connected to this recard.
Subprime reported amounts for another project.

Check #216566 was for $20,743.06

Private Comments These commants are visible ONLY to the compliance officer.

Attach File(s)

Confirmation [[] send me confirmaticn of my response.

Save Response

9. Click “Save Response” button

VI.Adding a New User

1. Click on “Settings” tab in left margin

2. Click on “Add a User” (to grant employee access to your firm’s account)
3. Click on “Add User” button

Vendor Profile: Users Help & Tools 3¢
Azl{lﬁﬁg?ﬁg‘ General Infa | Pubic Profle | Users | Gommodity Godes| Contacts| Employees | Gertrisations | Gontrasts| Warkforse Compostion/EED | AZUTRACS Registrations |

ADOT Contractor Compliance System Vendor Number: 20373918

Listed are all of the users accounts for this business. To view a user's information, click the user number or name.
S
Contact Role(s) Actions

20373918-001 Compliance, Contractor Cerlifications, Contracts, General, Copy
Insurance, Invoicing, Owner, Prevailing  Deactivate
Settings » Wage, Sales
‘Change Password
Your Settings
General Biz Info
Vendor Profile
Add a User l
Contacts
Commaodity Codes
Employess
Warkforce/EED
AZUTRACS Registrations

User Number

Customer Support

Home | Help | Print This Pags | Print Te POE
Copyright € 2015 B2Gnaw. Al rights reserved.

4. Complete all fields with a red asterisk (*) - the email address is considered the Username

Using the LPA DBE System




5. Enter a generic password: As soon as the new user logs into the System, they will be asked to
create a new password

I* required entry
Contact Information
Enter the user's contact information. The email address serves as the the username.

SalutationFirst Name * Last Nama *

Jane Doe

Name *

Email/Username * jdoe@gmail.com
Title
Phone Number * 602 7127761 | Ext

Fax Number = 602 712-8429

Choose password *
111111111}

Password requirements:

Retype password = ssssnens

6. Select all addresses

Select the addresses for this user. To edit or add addresses, click the General Info tab at the top of this page.

Physical * Main Address: 1130 N. 22nd Ave.. Phoenic, AZ BSUDSﬂ
Mailing * Main Address: 1130 N. 22nd Ave.. Phoenic, AZ BSUDSﬂ
Billing * Main Address: 1130 N. 22nd Ave.. Phoenix, AZ BSUDQﬂ

Shipping * Main Address: 1130 N. 22nd Ave.. Phoenix, AZ 85009 v|

7. Select the applicable “Time Zone”
8. Select “Email” or appropriate methods

Account Preferences

Select the timezone, language, and notification settings for this user.

Time Zone * US/Arizona ﬂ

Preferred Notification Method * h ) ]
() Email AND Fax: Send me plain-text email ﬂ

(®) Email: Send me plain-text email ﬂ
() Fax
Notification Options 7] Notify this user of new system features and services. Uncheck the box to not receive these notices.

Motify this user of outreach campaigns, such as seminar, training bulleting, and procurement opportunities. Uncheck the
box to not receive these notices from Arizona Department of Transportation. This action has no impact on official
correspondence sent as part of any applicable agreement, contract, certification, or policy.

| Save | | User List |

9. Click “Save” when complete




10. Below message appears and click “OK”

Message from webpage

ié User information saved.

[

. Click “User List” button

fy this user of outreach campaigns, such as seminar, ira
io not receive these notices from Arizona Department o

lespondence sent as part of any applicable agreement, |

[ UserLisi]

Save Changes l

12. See new user in the list
Vendor Profile: Users Help & Tools 3§
AZUTRACS 592 General nio | Pubic Profle | Users | Commodity Codes | Contacts | Employees| Certifcations | Contrscts| positi i |
‘System Vendor Number: 20373918

LpA DBE Systern ML
ADOT Contractor Compliance
Listed are all of the users accounts for this business. To view a user's information, click the user numbser or name.

T £
Actions

Home
User Number Contact Role(s)
Certifications, Confracts, General, Copy
Insurance, Invoicing, Owner, Prevailing  Deactivate

20373918-001 Compliance. Contractor
Wage, Sales

20373812002 Doe. Jane

13. Go to Step #3 to add additional users




VII. Closing a Contract

1. Click on “Search” in left margin, and then “Contracts”

Search: Contracts
AZUTRACS & 2

LPA DBE Systom M
Ussrs | vendors | Contracts I

&

Search your organization's contract database. Enter information inte any of the boxes below and click Search. Some parameters are required.

Search First 20 Matches I l Search All Matches ] l Clear Form ]

Vendors

T Search Parameters

CONTRACT/REFERENCE NUMBER

Reporting »

Create »

(Contract number, finandial system reference, project number]

CONTRACT TITLE

Tools » CONTAINING TEXT
. (Conzract description, summary. nates, comments)
Settings »

Help & Support » CONTRACTOR
Loaoff

® prime O Subcontracior O Either

2. Enter “Contract/Reference Number” and click on “Search All Matches”

3earch: Contracts

Users l \fendorsl Contracts l

earch your organization's contract database. Enter information into any of the boxes below and click Search. Some parameters are required.

Search First 20 Matches Search All Matches I Clear Forr

Search Parameters

CONTRACT/REFERENCE NUMBER

project number)

CONTRACT TITLE

CONTAINING TEXT

(Contract description, summary, nates, comments)

CONTRACTOR : : :
® Prime U Subcontractor U Either

3. Select the relevant “Contract Number” and click on “Main”

Search: Contracts
Usars | varators | Cantracts l
Here's 3 kst of the contracts that matched your search ¢riteria. Use the sort and filter functions of the table to recuce the size of the Iist. You can view more istings by using the navigaton line at the botiom of the table.

Cack the Transaction Number 10 view that Contract of e Vendor Name Ini 1o view Mat vendors profie. To refng of expand your $8arch use the search tatie at the bottom of the page.

To resart, chek o colimn title,

Lontrast Ameount &
‘Brime Conracror End Date

Al v ALL ¥

$443,906
ww/zo1e

Using the LPA DBE System




4. C(Click on “Closeout”
5. Enter “Close Date”
6. Then “Close out Contract”

Contract Management: Close Contract

Main | Wiew ‘ Settings | Subs | Docs ‘ Change Orders & Task Orders | Alerts ‘ Comments | Messag

Compliance Audit List | Compliance Audit Summary | Compliance Audit FY | Site Visits | Reports |
SZ12901X: 171677 - Bicycle/Padestrian Program Services

Prime: Living Streets Alliance
8/10/2017 - 8/9/2018

Close Contract

Contract Status Open
Close Date * mmy/dd/yyyy)
Contract Secondary Status None selected *

Prime Contractor Rating Mot Rated »

Closeout Comments

Close Out Contract ‘ \ View Audit Summary With 'Final Audit' Te

7. On the pop-up window, click “OK”

arizonalpa.dbesystem.com says
Closs out this contract? It will no longer be audited and its status will be set
to "Closad”,

8. The contract is now “Closed”

Contract Management: Close Contract

Main | View | Settings ‘ Subs | Docs | Change Orders & Task Orders | Alerts | Comments | Messages | Closeout ‘

Compliance Audit List | Compliance Audit Summary | Compliance Audit FY | Site Visits | Reports ‘
SZ12901X: 171677 - Bicycle/Pedestrian Program Services

Prims: Living Streats Alliance
8/10/2017 - 8/9/2018; Clos=d 10/1/2019

Contract Status
Contract Status

Contract Secondary Status None selected ¥

Close Date * 10/1/2019 (mm/dd/yyyy)
Closed By Melanie Peterson
Prime Contractor Rating Not Rated ¥

Closeout Comments




VIII. Re-Opening a Contract

If you closed a contract in error, fret not. It is as easy as “1, 2, 3” to re-open it. Actually, only “1” and
112":

1. Go to the “Main” page, then click on “Reverse Close Out”

Contract Management

| Settings | Subs ‘ Docs ‘ Change Orders & Task Orders ‘ Aleris | Comments ‘ Messages ‘ Closeout |

Compliance Audit List | Compliance Audit Summary | Compliance Audit FY | Site Visits ‘ Reports |

e  —— Services
Prime: Livism——
8/10/2017 - 8/9/2018; Clos=d 10/1/2019

Contract Information

Contract Title = pesmmram Services
Contract Number

Prime Contractor

System Transaction Number

Award/Start Date 811012017

(Projected) End Date 8/9/2018

Contract Value $443,986.00

Contract Alerts

Alert 1 Contract has been closed.

Contract Status & Actions

Status

Contract Status View Contract, Edit Contract, Close Qut
Change Secondary Status to:
None selected ¥
Compliance Officer Assigned Change Compliance Officer ta:

M

Compliance Monitoring On Demand (Monthly)

Subcontractors 1sub Manage Subcontractors

Task Orders Create Task Order

Contract Change Orders Amended Amend Contract Change Value

Contract Extensions/Shortenings L tract
Other Functions Reverse Close Out [Delete Contract, Vendor Archi

2. Click on “OK” and boom, you’re back in business

ipients :
arizonalpa.dbesystem.com says

Activate this contract?
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